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Pagsisimula sa Silhouette CAMEO®

Pagkonekta ng iyong Silhouette CAMEO®

Silhouette CAMEO®kasangkapan sa 
pagputol na nasa desktop

A/C adapter at 
pansaksak

USB cable

1

alisin ang foam

1 

12” mat sa 
pagputol

Tingnan ang Kasamang mga Aytem

Ang Silhouette CAMEO® ay may kasamangaytem na ipinapakita sa sumusunod na listahan. Tingnan 
kungandiyanlahat ng aytem bago magsimula. Kung may kulang sa mga aytem na nakalista sa ibaba, 
pakikontak ang support@silhouetteamerica.com.

Kunin ang Silhouette CAMEO® sa kahon at alisin ang tatlong lastay ng packing tape at foam na suporta tulad 
ng nasa sumusunod na diagram. Ang mga lastay ng tape at foam na ito ay ginagamit para hawakan ang 
kumikilos na mga bahagi ng Silhouette habang ibinibiyahe.

crosscut blade

alisin ang tape

AutoBlade Bluetooth® na 
pantanggal na tool
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I-install ang Silhouette Studio® na Software

Pag-install
1.  Pumunta sa silhouetteamerica.com.
2. I-click ang asul na “Update Software” buton sa itaas ng screen. 
3. Sa ilalim ng “Silhouette Studio” i-click ang link sa pag-download. Tiyaking pinili mo ang tama para sa 
iyong operating system (Windows o MAC). 

PARA SA WINDOWS: Simulan ang proseso ng pag-install sa pamamagitan ng pagsunod sa sinasabi 
sa screen. Kapag hindi awtomatikong lumabas ang window sa pag-install, hanapin ang download sa 
My Computer at i-click nang dalawang beses ang setup.exe na programa para patakbuhin ito. Kapag 
lumabas ang“New Hardware Found” sa dialog box, sundin ang rekomendadong mga tagubilin para 
tanggapin ang pag-install ng sistema mo ng driver ng Silhouette.

PARA SA MAC: Hatakin at ihulog ang Silhouette Studio® na icon ng aplikasyon sa folder ng mga 
aplikasyon para ma-install ang Silhouette Studio®.

Ikonekta ang Silhouette CAMEO®

Sa sandaling naka-install na ang software ng Silhouette Studio®, ikonekta ang Silhouette CAMEO® 
sa suplay ng kuryente. Ikonekta pagkaraan ang Silhouette sa computer mo gamit ang kasamang USB 
cable na ipinakita sa diagram. 

Buksan ang makina sa pamamagitan ng pagpindot sa buton ng kuryente. Sundan ang mga sinasabi 
sa touchscreen para piliin ang wika mo at simulan ang inisyal na setup. Kapag ipinakita ng PC mo ang 
“New Hardware Found” na dialog box, sundin ang rekomendadong mga tagubilin para matanggap ang 
pag-install ng sistema mo ng driver ng Silhouette.

Bluetooth®
Ang Silhouette CAMEO® ay kabagay ng Bluetooth® at pinapahintulutan ang wireless na komunikasyon. 
Ang “Silhouette CAMEO® Bluetooth® Edition” ay may kasamang nakakabit nang Bluetooth® adapter. 
Para sa lahat ng edisyon ng Cameo, nakalagay ang Bluetooth®, pero kakailanganin mong mag-install 
ng Bluetooth® adapter. Ang Bluetooth® ay nasa ilalim ng makina sa isang kahong mabubuksan ng 
screwdriver. 
Upang ikonekta ang iyong pinagaganang Bluetooth® na CAMEO 3, tiyaking naka-activate ang iyong 
Bluetooth®. Dapat mong makita ang simbolong Bluetooth® sa kaliwang itaas na gilid ng iyong CAMEO 
screen. Kung walang simbolo na naroroon, i-activate ang Bluetooth® sa “BLUETOOTH” menu na 
matatagpuan sa loob ng mga setting ng CAMEO 3 machine (         ).

kuryente

Piliin ang “Idagdag ang Bluetooth Cutter…” mula sa Silhouette menu na matatagpuan sa itaas ng iyong 
Silhouette Studio® software. Lilitaw ang dialog box na ipinakikita ang mga device na Bluetooth®. Piliin 
ang CAMEO 3 mula sa listahan ng mga device at magsisimulang mag-sync ang software. Pagkatapos ng 
ilang segundo, ipakikita ang status ng CAMEO bilang “Handa” sa panel na IPADALA SA SILHOUETTE at 
kumpleto na ang pagsasaayos.

Naka-off ang Bluetooth® 
(o walang Bluetooth® adapter ang naroroon)

Naka-activate ang 
Bluetooth® ngunit 
hindi konektado

Naka-activate ang 
Bluetooth® at 
konektado

No 
Symbol



Pagsisimula sa Silhouette CAMEO®

PANSININ: Para palitan ang yunit ng sukat mula sa sistema ng U.S. tungo sa sistemang metriko, 
piliin ang File -> Preferences… (Silhouette Studio® -> Preferences… sa Mac®). Sa ilalim ng 
seksiyon na Measurements ng dialog box ng preferences makikita mo ang ilang iba't ibang yunit 
na pansukat.
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Paano Pumutol sa Iyong Silhouette CAMEO®

Pagbukas sa Silhouette Studio® na Software
Hanapin ang icon ng Silhouette Studio® sa desktop, o sa Start Menu ng PC mo 
(sa folder ng mga Aplikasyon sa Mac®). I-click nang dalawang beses ang icon para 
patakbuhin ang aplikasyon.

Kapag naka-load na ang Silhouette Studio®, mapapansin mo ang blangkong 12” x 12” 
na pahina sa screen mo.

Kung gusto mong palitan ang mga dimensiyon o oryentasyon ng pahina, makikita mong 
bukas na ang mga opsiyon sa setup ng pahina sa isang panel sa kanang bahagi ng screen.

Para mapuntahan ang mga opsiyon sa setup ng pahina sa hinaharap, i-click ang icon ng 
Design Page Settings sa options toolbar sa itaas na kanang sulok ng screen mo.
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Pagsisimula sa Silhouette CAMEO®

Pagguhit ng Teksto

	Para pumutol ng mga letra o salita gamit ang alinmang font sa computer mo, piliin ang text 
tool mula sa 
	toolbar na nasa kaliwang bahagi ng screen. Pagkapili sa text tool, i-click saanman sa 

	 pahina at magsimulang tumipa.

Pagkatapos i-click sa pahinang may text tool, lalabas ang kumukurap na cursor. Magsimulang tumipa 
ng anumang letra, salita o pariralang pinili mo.

Habang tumitipa o nag-eedit ka ng teksto, ang panel sa mga opsiyon sa teksto ay lalabas sa 
kanang bahagi ng screen. Sa panel na ito puwede mong palitan ang font, sukat ng teksto, timbang, 
justification, espasyo sa pagitan ng mga karakter at espasyo sa pagitan ng mga linya. Gamitin ang 
mouse para itampok ang teksto mo bago gumawa ng mga pagbabago sa font, sukat, bigat, atbp.

Para matapos ang pagtipa ng teksto mo, i-click saanman sa labas ng pahina. Tatapusin nito ang moda 
ng pag-edit sa teksto at aalisin sa pagkapili ang teksto. Kung kailangan mong may baguhin sa teksto, 
i-click nang dalawang beses ang teksto sa pahina gamit ang Select Tool (matatagpuan sa kaliwang 
toolbar).

Para maikilos ang teksto mo sa buong pahina, i-click at hatakin ito sa bagong lokasyon.

Para palitan ang sukat ng teksto mo, piliin ang teksto at i-click at hatakin pagkaraan ang isang sulok ng 
mga hawakan ng kontrol.

Para paikutin ang teksto mo, piliin ang teksto, i-click at hatakin pagkaraan ang berdeng bilog na 
nakikita sa ibabaw ng bagay.
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Pagguhit ng Simpleng mga Hugis

Ang Silhouette Studio® ay may nakalagay nang functions para gumuhit ng simpleng mga hugis tulad 
ng bilog, parisukat, parihaba, linya, polygon, at freehand line art. Bawat isa sa kasangkapang ito ay 
matatagpuan sa toolbar sa kaliwang bahagi ng Silhouette Studio® na window.

Mga Linya
Para gumuhit ng linya, piliin ang Line Tool sa kaliwa ng toolbar. I-click at hatakin ng 	
mouse para magdibuho ng linya, o i-click minsan para simulan ang linya at i-click ulit para 
tapusin.

Hwakan ang SHIFT habang lumilikha ng linya para magawang perpektong patayo, pahiga o 45° na 
linya.

Mga Parihaba/Mga Parisukat
 Para gumuhit ng parihaba, piliin ang Rectangle Tool mula sa kaliwa ng toolbar. I-click at 		
 hatakin ng mouse para magdibuho ng parihaba, o i-click minsan para maglagay ng isang sulok 
at i-click ulit para ilagay ang katapat na sulok.

Hawakan ang SHIFT habang lumilikha ng parihaba para makagawa ng perpektong parisukat.
Hawakan ang ALT (OPTION sa Mac®) para magdibuho ng parihaba mula sa gitna sa halip na sulok.
Hawakan ang SHIFT + ALT (SHIFT + OPTION sa Mac®) para magdibuho ng perpektong parisukat na 
nakasentrro sa orihinal na click mo.
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Pagputol sa Disenyo Mo

Paghanda sa Mat sa Pagputol

Pagtanggal ng di-dumidikit na pangguhit sa mat sa pagputol.

Iposisyon ang papel mo o ibang media sa mat sa pagputol ayon sa diagram na ipinakita sa 
Silhouette Studio®. 

Kung wala kang makitang imahe ng mat sa pagputol sa ilalim ng dokumento mo sa screen, 
i-click ang Page Setup na buton sa options toolbar sa kanang sulok ng window.

Iposisyon ang imahe mo sa screen kung saan mo gustong putulin sa mat. Siguraduhing napanatili mo 
ang disenyo sa pulang gilid ng pahina mo.

7
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Paghahanda sa pagputol ng Silhouette
Buksan ang Silhouette CAMEO® sa pamamagitan ng pagpindot sa buton ng kuryente at paghintay na 
magsimula ang makina. 

Para mailagay ang mat sa pagputol sa Silhouette, angatin ang takip, ihanay ang kaliwang gilid ng mat 
sa asul na marka sa paghanay sa kaliwang bahagi ng makina, ilatag ang mat sa puting mga gulong, at 
pindutin ang "Load cut mat" na buton sa LOAD screen.
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Ang pag-load ng materyal na may sariling suporta at hindi kailangan ng mat sa pagputol (tulad ng 
vinyl), ay kailangan ng prosesong katulad ng nasa itaas pero dapat mong piliin ang "Load media"

Kung gumagamit ng linyadong materyal nang walang mat sa pagputol, puwede kang gumamit ng 
crosscutter na nasa likod ng makina para tabasan ang proyekto mo pagkatapos putuin. Ilagay lang 
ang crosscut blade sa daanan at padaanan nito ang materyal mo sa direksiyong nakasaad sa crosscut 
blade. Ang crosscut blade ay matatagpuan sa storage compartment.

Pagpapalit ng mga Gulong para sa Mas Maliit na Media
Sa pamamagitan ng pagpalit sa mga gulong sa main roller shaft, ang Silhouette CAMEO® ay kayang 
putulin ang sumusunod na sukat ng media: A4, letter, 12”, and 13”.

Hanapin ang release lever sa kanang bahagi at pihitin pakanan.

Gagapin ang katawan ng gulong at roller head at pihitin sa bukas 
na posisyon. 

Padulasin ang gulong sa nais na posisyon at pihitin pasara.

puting mga gulongcrosscut blade

ROLLER HEAD

KATAWAN NG 
GULONG

INDICATOR BUKSAN

ISARA
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Mga Talim
Ang iba't ibang estilo ng talim ay pinapalitan sa iba't ibang paraan. Ang mga tagubilin sa pagpapalit ng 
pampalit na mga uri ng talim ay isasama sa pakete ng talim. Sa lahat ng pagkakataon, ang mas mataas 
na setting ng talim ay naglalantad sa mas maraming talim at para sa pagputol ng mas matalim na mga 
materyal. Tingnan ang Silhouette Studio para sa rekomendadong setting ng talim para sa iba't ibang 
materyal. 
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Ang AutoBlade ay kayang awtomatikong magbago alinsunod sa settings ng pagputol ng software mo. 
Para manwal na baguhin ang AutoBlade, isuksok ang dulo ng talim sa adjustment socket ng talim tulad 
ng ipinakita. Marahang pisilin ang Autoblade pataas at pababa sa adjustment socket hanggang ituro ng 
pulang indicator line ang nais na setting. 

Setting ng 
talim

1

4-6

7-10

2-3

Materyal

Manipis na mga materyal tulad ng vinyl at materyal na madulas ang paglipat ng init

Makapal na mga materyal tulad ng textured cardstock at mga papel na may padron

Makapal na mga materyal tulad ng kambas

Ang mga materyal na katamtaman ang bigat tulad ng papel, cardstock at materyal na 
sabay-sabay ang paglipat ng init

PANSININ: Ang AutoBlade ay puwede lang gamitin sa kaliwang panghawak ng kasangkapan. 

hawakan ng kandado

kasangkapan

panghawak ng 
kasangkapan 1

panghawak ng 
kasangkapan 2

Dual-Carriage Setup
Ang CAMEO ay nagbibigay ng dual-carriage para hawakan ang 
dalawang magkaibang kasangkapan nang magkasabay. Papayagan 
ka nitong magsagawa ng iba't ibang aksiyon habang nasa parehong 
trabaho. Ang dalawang lalagyan ay tinatakan ng pula (o Kasangkapan 
1 sa kaliwang panig) at asul (o Kasangkapan 2 sa kanang panig). Ang 
mga kasangkapang ay puwedeng palit-palit na gamitin sa alinmang 
lalagyan, maliban sa AutoBlade na puwede lang gamitin sa kaliwang 
panig.

Para maikarga ang kasangkapan sa nais na 
lalagyan, buksan ang panghawak ng 
kasangkapan sa pamamagitan ng 
marahang pagpisil at paghatak sa 
panghawak ng kasangkapan. Ilagay ang 
kasangkapan sa panghawak ng 
kasangkapan at itulak ang nakalabas na 
bahagi pabalik para makuha ang kasangkapan. Siguraduhing lubos na 
nakalapat ang kasangkapan sa panghawak.

INDICATOR LINE

ADJUSTMENT SOCKET

AUTOBLADE

unlock lock buksan                isara
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Pumuputol

I-click ang buton ng Settings ng Pagputol sa toolbar sa ibabaw ng screen. Ang panel ng 
Settings ng Pagputol ay lalabas sa kanang bahagi ng screen.

Kung gumagamit ng maraming kasangkapan, puwede mong itakda kung aling mga linya ang isasagawa 
ng bawat kasangkapan. Ito ay puwedeng gawin sa isa sa dalawang paraan.

Kung ginagamit ang default na “Standard” Cut Mode, puwede mong piliin ang imahe mo sa lugar na 
gawaan at i-click sa Tool na gusto mong itakda sa imahe.

Kung ginagamit ang “Advanced” Cut Mode, puwede mong italaga kung aling kasangkapan ang 
gagamitin mo sa kulay ng linya o kulay na pampuno ng imahe sa pag-click ng nais na Tool. 

Puwede mong palitan ang ayos ng pagputol (kung naaayon) sa ilalim ng Cut Conditions menu.

 Sa loob ng panel ng Settings ng Pagputol, mapapansin mo ang isang listahan ng komon na  mga uri ng 
media kasama ang iba't ibang  timbang ng papel, vinyl, at iba pang materyales. Piliin ang akmang uri 
ng media mula sa listahan. Kung ang media na pinuputol mo (o katulad na media) ay hindi lumilitaw sa 
listahan, puwede mong piliin ang "Custom" mula sa listahan at manwal na baguhin ang bilis at kapal 
para sa Silhouette.

Sa pangkalahatan, kailangan ng mas makapal na mga materyal ang mas mataas na kapal at ang 
masinsing mga disenyo ay kailangan ng mas mabagal na pagputol.

Sa sandaling napili mo na ang akmang settings ng pagputol, i-click ang buton ng Ipadala sa Silhouette 
sa  ilalim ng panel sa kanan. 

Sa sandaling tapos na sa pagputol ang Silhouette, p indutin ang “Unload” na buton.

Maingat na talupin ang disenyo ng pinutol mo. Talupin ang natirang papel/media sa mat sa pagputol. 

Gumamit ng kasangkapang pangkayas ng Silhouette para makayas ang sobrang mga piraso ng papel sa 
mat.
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Piliin 
Uri ng Media

Ipadala sa 
Silhouette

Ayos ng Pagputol
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Library Ko

Tignan ang mga Disenyo

I-click ang buton ng Library Ko para makita ang mga disenyo ng Silhouette na nasa computer 
mo. Kasama sa Silhouette Studio® ang 100 libreng mga disenyo para matulungan kang 
magsimula. Ikonekta ang CAMEO sa computer mo at buksan ito para makuha ang 100 libreng 
disenyo mo.

I-click ang shortcut ng Ipakita Lahat ng Disenyo sa kaliwang panel ng Library Ko para tingnan ang lahat 
ng 100 disenyong kasama sa software mo.

I-click ang icon na susunod sa folder ng Library Ko para palakihin ang folder at matingnan ang 
nilalaman nito. Ang folder na ito sa simula ay naglalaman ng kasamang 100 libreng disenyo. 

Gamitin ang buton ng Tingnan bilang Icon at ang buton ng Tingnan bilang Listahan 
para palitan ang pagtingin sa mga disenyo mo sa kanang panel. Sa Tingin sa Listahan, 
puwede mong ayusin sa pamamagitan ng pangalan, uri ng disenyo, pangalan ng 
artista, at petsang nai-download.

11
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Pag-hahanap ng mga Disenyo

Puwede mong organisahin ang mga disenyo mo sa loob ng Library Ko para madalian ka sa 
pamamagitan ng paglikha ng bagong folder para sa mga disenyo mo. 
 

Naka-highlight ang folder ng Library Ko, i-click ang buton ng Bagong Folder sa toolbar na asa 
ibabaw ng window ng Library Ko, at tipahin pagkaraan ang pangalan ng bagong folder mo.

Piliin ulit ang folder ng Library Ko para ipakita ang 100 disenyong meron ka na.

Ilipat anumang disenyo mula sa kanang panel papunta sa bagong likhang folder mo sa panel ng mga 
folder sa kaliwa. Ang mga numero sa mga panaklong na katabi ng bawat folder ay nagpapakita kung 
ilang hugis ang kasama sa bawat folder.
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Silhouette Cloud
Ang Silhouette Cloud ay kasabay na nagtratrabaho ng Silhouette Studio® para panatilihing naka-
sync ang mga disenyo mo sa maraming device. Puwede kang mag-sync nang hanggang limang 
device sa Cloud account mo. Kung hindi ka gumagamit ng maraming device, ang Silhouette Cloud ay 
makatutulong sa pag-backup ng mga disenyo mo at pagpigil sa pangangailan ng pag-recover. 

Sa Silhouette Cloud, walang hangganan ang makukuhang imbakan ng download para sa Silhouette 
Design Store. May makukuhang 1GB  para sa custom content. Ang mga Miyembro ng Club Silhouette 
ay tatanggap ng 5GB na imbakan ng custom content. 

Para ma-sync ang files mo, ilipat ang mga ito sa cloud icon sa folder ng Library mo. Sasabihan ka ng 
software na mag-sign in sa Cloud sa account ng Silhouette mo. Kapag naka-sign in ka na, sisimulan ng 
Cloud mo na mag-sync sa mga disenyo mo.

Ang Cloud Library mo ay mananatili sa sarili nitong folder sa Library mo. May opsiyon kang i-save ang 
mga bagay sa ilalim ng Local User na folder mo o sa iyong Cloud Library, na may titulo ng email mo sa 
Silhouette Account. Ang mga file na na-save sa folder ng Local User ay makukuha mula sa device lang 
na iyon.
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Hinahanap ang mga Disenyo

Sa ibabaw ng window ng Library Ko makakakita ka ng kahon sa paghahanap. I-click ang kahon ng 
teksto at itipa ang isang susing salita para maghanap sa library ng mga imahe mo. Ang mga resulta ng 
paghahanap ay lilitaw sa kanang panel ng Library Ko.

Kung gusto mong tingnan ang mga susing salita at paglalarawan para sa isang hugis na ginamit sa 
paghahanap, i-click sa kanan (Control Click sa Mac®) at piliin ang Ipakita ang mga Katangian. Sa ilalim 
ng Library Ko lalabas ang mga detalye tungkol sa naka-highlight na hugis. Ang mga hugis na na-
download mula sa Silhouette Design Store ay magtataglay ng ilang susing salita at paglalarawan o mga 
tagubilin.

Paggamit ng mga Disenyo sa Library Ko

Gamit ang mga folder sa Library Ko, pumunta sa isang disenyong gusto mong itabas. Pindutin nang 
dalawang beses ang disenyo para mailagay ito sa pahina mo sa software. 

Awtomatiko nitong isasara ang Library Ko na madaling buksan ulit sa pag-click ng buton  na 
Library Ko sa kaliwang toolbar ulit.

	
Para isara ang Library Ko nang hindi nagdidikit ng dinseyo, i-click ang buton na Isara sa itaas na kanang 
sulok ng lugar ng Library Ko.

13

kahon sa paghahanap
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Mag download ng Bagong mga Hugis

Kumokonekta sa Silhouette Design Store

Ang Silhouette Design Store ay nagtataglay ng libong disenyong tatabasin sa Silhouette o mula sa 
simpleng cutout hanggang masinsing padron at disenyo. Karamihan ng mga hugis ay 99¢ lang. Sa 
pangkalahatan, isang libreng hugis din ang ipinapaskel kada linggo.

	Para puntahan ang Silhouette Design Store, i-click ang buton ng Design Store sa toolbar sa 
	kaliwang panig ng window.

Ang libreng disenyo ng linggo ay ipapakita sa home page na lilitaw.
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Tumingin ang bagong mga disenyo

Ang Silhouette Design Store ay parang anumang web page at puwedeng puntahan sa pag-click ng iba't 
ibang link para tignan ang bagong labas, popular na disenyo, atbp. Ang home page ay nagtataglay ng 
popular at bagong mga disenyong maaaring interesado ka. 

Sa ngayon, subukang mag-download ng libreng disenyo sa pamamagitan ng pag-click sa buton ng 
libreng disenyo sa linggong ito sa home page o paghanap sa tab ng Libreng Disenyo. 

I-click ang disenyo sa mga resulta ng paghahanap para makita ang mga detalye tungkol sa disenyo. 
I-click ang buton ng Idagdag sa Cart para maidagdag ang libreng disenyong ito sa shopping cart mo. 

	Hanapin ang icon ng shopping cart sa ikanang sulok sa itaas ng window at i-click 
	ito para tingnan ang shopping cart mo. Ang suma ng shopping cart mo ay dapat $0.00.

I-click ang buton ng Checkout para magsimula. Sa sandaling ito hihilingin ng sistema na mag-sign in ka 
bago mag-download. Ang paglikha ng bagong account ay tatagal nang ilang sandali lamang. I-click ang 
link na Sign up Free sa pahina ng login para makalikha ng bagong account.
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Pagsisimula sa Silhouette CAMEO® 16

Lumilikha ng account

Ilang iba't ibang uri ng account meron. Kapag mas pamilyar ka na sa Silhouette Design Store, maaaring 
naisin mong bumili ng suskripsiyon at mag-download ng dose-dosenang disenyo kada buwan. 
 

Para makalikha ng libreng account at makabili ng mga disenyo nang paisa-isa, piliin ang opsiyon na 
"Sign up FREE".

Hihingin ang iyong pangalan, email at password para makalikha ng account. Itipa ang impormasyon 
mo at i-click ang buton ng Sign Up. 



Pagsisimula sa Silhouette CAMEO®

Kapag nalikha na ang account mo, kakailanganin mong puntahan ulit ang shopping cart mo 
at subukan ang proseso ng checkout ulit. Hihilingin sa iyong mag-validate ng password mo 
tuwing 	 nagda-download ka ng mga disenyo. 

Itipa ang password mo para pahintulutan ang download.

 

Habang nagsisimulang mag-download ang disenyo mo, lalabas ito sa folder ng Recent Downloads ng 
Library Ko na lilitaw sa screen na ipinapakita ang progreso ng download. Anumang bagong disenyong 
i-download mo mula sa Silhouette Design Store ay lilitaw sa espesyal na folder na ito at puwedeng ilipat 
sa anumang folder na pinili mo. 

Pindutin nang dalawang beses ang bagong download na disenyo mo para mailagay ito sa kasalukuyan 
mong dokumento.
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Pagsisimula sa Silhouette CAMEO® 

Ginagamit ang iyong pansubok na kard ng suskripsiyon
Kung may kasamang pansubok na kard ng suskripsiyon ang Silhouette mo, maaari mo itong gamitin 
sa pagbili ng mga disenyo mula sa Silhouette Design Store. Pagkatapos irehistro ang makina mo 
sa silhouetteamerica.com/setup, papadalhan ka ng email ng unique code na nagbibigay sa iyo ng 
1-buwang Batayang suskripsiyon sa Silhouette Design Store. Sundin ang mga direksiyon sa email para 
ma-activate ang pansubok na suskripsiyon mo at magsimulang ma-enjoy ang Silhouette Design Store.

Ang makukuhang mga kredito ng suskripsiyon mo ay matitingnan sa kanang sulok sa itaas ng screen sa 
ilalim ng search bar.
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Pagsisimula sa Silhouette CAMEO®

Gamit ang USB Device mo sa 
Silhouette CAMEO®
Pag-save sa USB Device Mo

Magbukas o lumikha ng hugis sa Silhouette Studio® na software.

Palitan ang sukat ng disenyo mo sa sukat na gusto mong tabasin at ipuwesto ito ayon sa gusto.

Maglagay ng USB memory device sa computer mo.

Pumunta sa File > Save As na opsiyon (o CTRL + SHIFT + S) at i-save ang disenyo mo sa USB memory 
device.

Alisin ang USB memory device sa computer mo.
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Pagsisimula sa Silhouette CAMEO® 20

Paggamit ng USB Device sa iyong Silhouette CAMEO®

Habang nakabukas ang Silhouette CAMEO®, isuksok ang USB memory device mo sa suksukan sa gilid 
ng makina. Ikarga ang materyal mo sa Silhouette.

Habang nakalagay ang USB memory device at naka-load ang mat/media sa pagputol, lilitaw ang isang 
USB menu sa screen mo. Pindutin ang buton ng USB sa kaliwang sulok sa ilalim.

Mula rito, tignan ang files sa device mo at piliin ang nais mong imahe. Sa ibabaw magkakaroon ng 
imahe ng file mo para matulungan kang piliin ang hinahanap mo. 

Ang “Change Settings1” at “Change Settings2” ay magbibigay sa iyo ng daan para baguhin ang Settings 
ng Pagputol para sa bawat panghawak ng kasangkapan. Ang Settings ng Pagputol mo ay na-save nang 
nag-save ka ng file mo sa Silhouette Studio®, pero puwede mong baguhin ang mga ito kung kailangan. 
Puwede mo ring piliing magsagawa ng subok na pagputol dito.  

Kapag handa ka na, pindutin ang buton ng Ipadala. Ang trabaho mo ay puputol ayon sa mga 
ispesipikasyon mo.
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Silhouette CAMEO Mga Pag-iingat 
para sa Kaligtasan

• Ilagay ang Silhouette CAMEO sa hindi naaabot ng mga bata.
• Irebyu at itago ang dokumentong ito bilang sanggunian sa 
hinaharap.
• Ang Silhouette CAMEO ay isang elektronikong kasangkapang 
pamputol na kailangan ng maingat na paggamit at pagwahak. Para 
maiwasan ang personal na pinsala o pagkasira ng makina, pakibasa 
ang sumusunod na mga pag-iingat para sa kaligtasan. 

Mga kumbensiyong ginamit sa gabay na ito
Para magamit nang ligtas at wasto ang Silhouette CAMEO, gayon din 
para maiwasan ang pinsala sa tao at pagkasira sa pag-aari, dapat 
bigyan ng maingat na pansin ang bawat pag-iingat para sa kaligtasan 
sa dokumentong ito. Ang pagpalyang tumalima sa mga pag-iingat na 
ito ay maaaring magpawalang-bisa sa warranty ng produkto at 
anumang personal o pangkagamitang pananagutan sa pinsala.

Paglalarawan sa mga simbolong pangkaligtasan

Ipinapakita ng simbolong ito ang impormasyong kailangan ng 
maingat na pansin (kasama ang babala).

Ipinapakita ng simbolong ito ang aksiyong mahigpit na bawal.

Ang simbolong ito, katabi man ng imahe o kasama sa teksto, ay 
nagpapakita ng kilos na dapat gawin.

Ingat Kaligtasan BABALA

Huwag hipuin ang gumagalaw na mga bahagi habang pumuputol ang 
Silhouette.

Ilayo ang mga kamay at ibang bagay sa gumagalaw na mga bahagi 
kapag nakasaksak ang makina.

Huwag kalasin, kumpunihin, o iremodel ang Silhouette. Ang paggalaw 
sa Silhouette hardware ay puwedeng magdulot ng pagkakuryente o 
sunog dahil sa pagtagas ng kuryente. Kung kailangang kumpunihin ang 
Silhouette mo, pakikontak ang Silhouette Customer Service.

Huwag ikonekta ang Silhouette sa non-rated na suplay ng kuryente. 
Ang paggamit ng ibang boltahe ng suplay ay maaaring magresulta sa 
pagkakuryente o panganib sa sunog dahil sa pagtagas ng kuryente. 

Huwag gamitin ang Silhouette sa lugar na maaari itong 
malantad sa tubig, pagkabasa o alikabok.

Kapag ang Silhouette ay umusok, umamoy o di-normal na 
gumana, huwag ipagpatuloy ang paggamit dito. Hugutin ang 
ACadapter sa saksakan.

Ang paggamit ng Silhouette CAMEO na sobrang init ay maaaring 
magdulot ng panganib sa sunog o pagkakuryente. Huwag subukang 
kumpunihin ang Silhouette nang sarili mo.

Huwag padapuan ng alikabok o mga bakal ang pansaksak. 
Ang maruming pansaksak ay maaaring magdulot ng 
pagkakuryente o panganib sa sunog dahil sa pagtagas ng 
kuryente.

Huwag gamitin ang AC adapter o pansaksak kung sira. Ang 
paggamit ng sirang pansaksak o AC adapter ay maaaring 
magdulot ng pagkakuryente o sunog. Palitan ang sirang 
pansaksak at AC adapter.

Tanging AC adapter lang na kasama sa kahon ng Silhouette 
CAMEO ang gamitin.

Ang paggamit ng ibang AC adapter ay maaaring magdulot ng maling 
pag-nadar o magresulta sa pagkakuryente o sunog. Siguraduhing 
nakakonekta ang AC adapter sa CAMEO bago isaksak ito sa pader.

Matalas ang talim ng Silhouette.
Hawakan nang maingat ang lalagyan ng talim at huwag hawakan ang 
mismong talim. 

Huwag gamitin o itago ang Silhouette CAMEO sa isang lokasyong 
nakabilad sa araw o bugahan ng air conditioner o heater. Ang labis na 
init, alibabok at/o pagkabasa ay puwedeng magdulot ng maling pag-
andar sa makina.

Huwag gamitin ang Silhouette CAMEO sa lugar na sobra ang 
yugyog o elektrikal na ingay.

Huwag hatakin ang pansaksak para hugutin ang Silhouette.

Kapag may banyagang bagay/ sustansiyang pumasok sa 
Silhouette habang pinapatakbo, kanselahin ang proyekto sa 
pamamagitan ng pagpatay ng makina. Huwag subukang alisin 
ang banyagang bagay o magpatuloy sa pagputol.

Huwag tangkaing langisan ang Silhouette CAMEO. Hindi 
kailangan ng pampadulas ng Silhouette o anumang ahente para 
normal na tumakbo.

Huwag gumamit ng anumang ahenteng likidong panlinis o 
anumang likido sa loob ng Silhouette CAMEO o paligid ng 
control panel ng Silhouette. Sisirain ng mga likido ang pag-andar 
ng makina.

Siguraduhing sapat ang espasyo sa paligid ng Silhouette CAMEO 
habang pinapatakbo ang makina para hindi mabangga ng makina, media 
at mat sa pagputol ang mga bagay sa paligid nito.

Panatilihing di-kukulangin sa 3 piye ang layo ng Silhouette CAMEO sa 
anumang ilaw o pinagmumulan ng init.

Laging gamitin ang tamang setting ng talim para sa materyal na 
pinuputol mo. Ang paggamit ng masyadong malalim na setting ay 
puwedeng sumira sa mat sa pagputol at puwedeng masamang 
maapektuhan ang pagsasagawa ng pagputol.

Kapag manwal na inililipat ang lalagyan ng pamputol, mag-ingat at 
kumilos nang mabagal para hindi masira ang hardware ng Silhouette.

Para sa anumang tanong o alalahanin kontakin ang Silhouette Customer 
Service sa support@silhouetteamerica.com.

Ingat Kaligtasan BABALA
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Saan Makakakita ng Dagdag na 
Impormasyon

Kumpletong Manwal ng Gumagamit
Tingnan ang kumpletong nakadibuhong Manwal ng Gumagamit sa Silhouette Studio® sa pamamagitan 
ng pag-click sa Help -> User’s Manual.

Website
Bisitahin ang seksiyon ng tutorial sa www.silhouetteamerica.com para matulungan sa partikular na 
mga katangian at hakbang-hakbang na tagubilin kung paano putulin ang iba't ibang uri ng media sa 
Silhouette CAMEO®.

Blog
Bisitahin ang opisyal na Silhouette blog sa blog.silhouetteamerica.com para sa mga ideya ng bagong 
mga proyektong puwede mong likhain. Maraming paskel na blog ang naglalaman ng hakbang-hakbang 
na mga tagubilin sa abanteng paggamit ng mga produkto at software ng Silhouette.

Newsletter
Mag-sign up para sa Silhouette newsletter sa www.silhouetteamerica.com para makatanggap ng mga 
update sa produkto at espesyal na mga alok sa pamamagitan ng email.

Customer Service
Kung meron kang mga tanong, maging malayang kontakin ang customer service sa:

Silhouette America, Inc.
support@silhouetteamerica.com
(800) 859-8243 (US lang)
(801) 983-8937


